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Introduction  

Maternal nicotine use during pregnancy has been associated with long term 
neurobehavioral consequences in offspring. Consequences include increased susceptibility to 
drug addiction and increased likelihoods of developing neuropsychiatric disorders such as 
attention deficit hyperactivity disorder, depression, and autism (Cao et al. 2013). For these 
reasons, it has been advised that products containing nicotine not be used during pregnancy as 
the developing brain is a highly plastic structure where structural and functional components 
remain malleable (Dwyer et al. 2008). 

The underlying mechanisms for the consequences caused by prenatal nicotine exposure 
are not completely known. Previous research has shown that in the developing brain, nicotine 
interacts with endogenous acetylcholine receptors leading to interference in neurotransmitter 
functioning (Wickström 2007). This interference leads to a disruption in neurotrophic factors 
leading to developmental abnormalities (Wickström 2007). The effects caused by the disruption 
in neurotrophic factors are both complex and widespread. For these reasons, understanding the 
effects caused by this interaction may be critical in understanding the changes that are caused by 
exposure to nicotine during critical developmental periods.   

 One important developing feature of the central nervous system is myelin, a membrane 
structure created by neuroglial cells known as oligodendrocytes. Oligodendrocytes are important 
for producing the lipids and proteins that form the myelin sheath (Trapp et al. 2003). The myelin 
sheath is ultimately created during glial-axonal interactions (Trapp et al. 2003). Overall, myelin 
is important for the conduction of signals down an axon and works by increasing the velocity of 
action potentials (Webb and Webb 2017). Irregularities in myelin production have been 
implicated in causing many of the same neuropsychological effects as seen in prenatal nicotine 
exposure. For example, irregularities in myelination have been associated with increased drug 
addiction potential and increased likelihood of developing schizophrenia, bipolar disorder, and 
other psychiatric diseases (Cao et al. 2013). These similarities in disorder manifestation suggest a 
possible link between prenatal nicotine exposure and irregular myelination patterns.  

To investigate the possible link between prenatal nicotine exposure and irregular 
myelination, Gallus gallus neurons were exposed to two experimental concentrations of nicotine 
and were stained using FluoroMyelinTM Red, a fluorescent stain used to observe the presence of 
myelin. The purpose was to look at the effect of nicotine exposure on myelin. Gallus gallus 
neurons were used as they were both readily available and capable of being cultured in a short 
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period of time. Overall, I hypothesized that cultures exposed to nicotine would result in lower 
quantities of myelin in comparison to control cultures as measured by the fluorescent pixels that 
fluoresced above threshold in images of glial cells.  
 
Materials and Methods  
Dissections  
Dissection of 10-day old Gallus gallus embryos was performed following an established protocol 
(Morris R.L, 2019). Both sympathetic chains and dorsal root ganglia were collected and plated 
onto coverslips which had previously been cleansed and treated with both poly-Lysine and 
Laminin-CS following an established protocol (Morris R.L, 2019). Once plated the primary 
cultures were incubated at 37ºC for approximately 24 hours before experimental treatment.   
wcceDissections were performed by Professor Robert L Morris of the Biology department at 
Wheaton College, Norton, MA.  
 
Nicotine Stock Preparation  
A stock solution containing (-)-Nicotine produced by Sigma-Aldrich (N3876) and Ethanol was 
created to make two experimental conditions. The conditions were 1mM and .25 mM nicotine. 
These molar concentrations were chosen due to their previous experimental use by Chen et al. 
(2015). To produce these experimental values a stock solution at a concentration of 294 mM 
nicotine was created using 24.5 ul of (-)-Nicotine dissolved into 500 ul of Ethanol. The stock 
solution was prepared in the hood using sterile technique and proper protective equipment, it was 
then stored at 4ºC until ready to be further diluted and used in the experimental treatments. Both 
the stock solution and the experimental conditions were created and used in collaboration with 
Julia Roth and Samuel Crocker.  
 
Experimental Preparation  
Cell cultures of both high density and plated ganglion Gallus gallus neurons were treated 24 
hours following dissection. Two experimental conditions were created along with one control. 
The two experimental conditions were as mentioned 1 mM and 0.25 mM nicotine. To create 
experimental conditions a known amount of Nicotine Stock solution was diluted into 500 ul of 
growth medium. This dilution was then added to cell cultures with a known volume (1.5 ml). For 
the 1 mM dilution, 6.8ul of Nicotine Stock Solution was added and for the 0.25 mM dilution 
1.7ul of Nicotine Stock Solution was added. The experimental conditions were then incubated at 
37ºC for 8 days prior to staining and imaging. 
 
Control Preparation  
A carrier control was created using 6.8 ul of ethanol dissolved into 500 ul of growth medium. 
This solution was then added to the cell culture already in 1.5 ml of growth medium. The carrier 
control was then incubated at 37ºC for 8 days prior to staining and imaging. 
 
Fluorescent Staining using FluoroMyelinTM Red 
FluoroMyelinTM Red staining procedure was made following a protocol established in Monsma et 
al (2012). Experimental dishes and control dishes were stained on the 8th day following nicotine 
and control treatment. To stain one culture dish 5ul FluoroMyelinTM Red at a concentration of 
300x provided by Sigma Aldrich (F34652) was added to 500 ul of HBSS to create a final 
concentration of 3x. To stain, growth medium was removed from the culture dishes and replaced 
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with a small amount of HBSS to wash, this was then removed and the 3x FluoroMyelinTM Red 
solution was added to the culture dish. The culture dish was then incubated for 20 minutes at 
37°C. Following the 20-minute incubation, the culture dish was washed four times at three-
minute intervals. The stained cultures were then transferred to a chip chamber for imaging, chip 
chambers were made using an established protocol (Allen 2018). Fluorescent staining using 
FluoroMyelinTM Red was done in collaboration with Evan Lichter.  
 
Imaging 
Imaging took place immediately following chip chamber creation and was done at the Wheaton 
College Imaging Center for Undergraduate Collaboration. A Nikon Eclipse E200 Epi 
Fluorescent was used for imaging of glial cells. Images were taken at 40x phase 2 magnification. 
SPOT Insight FireWire 2 mega sample version 5.2 connected to an Apple iMac computer was 
used to acquire images. Images of each region were taken using both transmitted light and 
fluorescence. Red fluorescent images were taken with an exposure time of 10 seconds.  
 
Data Analysis 
All images were analyzed using ImageJ version 2.0.0-rc-69/1.52p. Data analysis was conducted 
in three parts to find the number of cells present, the area of fluorescent pixels above threshold, 
and the number of fluorescent pixels above threshold per cell. Data analysis was done in 
collaboration with Evan Lichter. 
Cell quantification   
Transmitted light images were used in order to identify the number of cells present. In this study 
an area where organelles were excluded and at least one nucleolus was present indicated the 
presence of one cell. If cells were difficult to identify, then both the fluorescent and transmitted 
light images were compared side by side. The fluorescent image helped identify areas of the cell 
where organelles were excluded as these were typically non fluorescent areas of the images.  
Area of fluorescent pixels above threshold 
In order to analyze the fluorescent pixels above the background signal a threshold was set so that 
the background noise could be omitted from the measurement. To begin analysis all fluorescent 
images were converted into 8-bit files. Fluorescent images were uploaded to ImageJ and 
converted through the following pathway “Image” → “Type” → “8-Bit”. The threshold was then 
set by using the auto threshold setting as this has previously been found to generate better 
binary images of glial cells than manual threshold (Healy et al. 2018). The Moments auto 
threshold algorithm was used as it has previously been found acceptable in analyzing glial cells 
(Healy et al. 2018). The Moments auto threshold was set using the following pathway “Image” 
→ “Adjust” → “Auto-Threshold” → “Methods” → “Moments” → “Ok”. Once the threshold was 
set the image was analyzed using the measure function. Measurements were limited to the 
threshold using the following pathways “Analyze” → “Set Measurements” → “Limit to 
threshold” → “Ok” area was found using the following pathway “Analyze” → “Measure”. Once 
the measurements appeared the area given was recorded. This area represented the number of 
pixels that fluoresced above the threshold.  
Number of fluorescent pixels above threshold per cell  
The area of fluorescence above threshold divided by the number of cells within the image 
yielded the number of fluorescent pixels per cell. Two fluorescent images from one culture in 
each condition after one trial were analyzed. The fluorescent pixels per cell were averaged for 
each condition. 
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Results 
Cells were identified by locating areas in which organelles were excluded and at least one 

nucleolus was present (Figure 1). Results from data analysis indicate that cells within the 0.25 
mM nicotine condition had the greatest number of fluorescent pixels per cell above the threshold 
brightness (Figure 3). The 0.25 mM nicotine condition resulted in more fluorescent cells (Figure 
2 C) as indicated by the area of fluorescent pixels above threshold (Figure 2 D). Cells within the 
1 mM nicotine condition had the second greatest number of fluorescent pixels per cell above the 
threshold brightness (Figure 3). Cells within the 1 mM condition resulted in less fluorescent cells 
than the 0.25 mM nicotine condition (Figure 2 E) as indicated by the smaller area of fluorescent 
pixels above threshold (Figure 2 F). Cells within the control condition had the smallest number 
of fluorescent pixels per cell above the threshold brightness (Figure 3). Cells in the control 
condition also had fewer fluorescent cells (Figure 2 A) in comparison to both nicotine conditions 
as indicated by the smaller area of fluorescent pixels above threshold (Figure 2 B). 
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Figure 1. Transmitted light images of control, 0.25 mM Nicotine, and 1.0 mM Nicotine. Images a,b,c 
show a transmitted light image from each condition taken before fluorescence. All images were taken at 
40x under phase 2. Arrows indicate where organelles were determined to be excluded and where at least 
one nucleolus was present. A.) Cells from control condition B.) Cells from 1 mM nicotine condition C.) 
Cells from 0.25 mM nicotine condition 
 
 
 
 

a. 
 

b. 
 

c. 
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Figure 2. Fluorescent and Moments Auto-Threshold images of control, 0.25 mM nicotine, and 1 
mM nicotine conditions.  Images A, C, E represent images under red fluorescence whereas images B, D, 
F represent the images once set to threshold using the Moments auto threshold A.) control condition glial 
cells under fluorescence B.) image A once set to threshold C.) 0.25 mM nicotine condition glial cells 
under fluorescence, many cells appear to be bright and fluorescent D.) image C once set to threshold  E.) 
1 mM nicotine condition glial cells under fluorescence F.) image e once set to threshold 
 
 

 

a. 
 

b. 
 

c. 
 

d. 
 

e. 
 

f. 
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Figure 3. Average number of fluorescent pixels/cell across control, 0.25 mM nicotine condition, and 
1 mM nicotine condition. The graph shows the average number of fluorescent pixels/cell for the three 
conditions: control, 0.25 mM nicotine, and 1 mM nicotine. Averages were created from images of 2 
regions of each condition from one trial. The control had the lowest number of pixels/cell at 7,283, 1 mM 
nicotine had the second lowest at 16,624 pixels/cell, and 0.25 mM nicotine had the highest at 18,088 
pixels/cell.  
 
Discussion 

Based on the results, the hypothesis that there would be less myelin in the nicotine 
conditions in comparison to the control is not supported by these data. Instead, these data provide 
preliminary evidence that nicotine conditions may result in more myelin. In the current study, the 
experimental nicotine conditions resulted in more fluorescent pixels per cell above threshold 
brightness. As can be seen in Figure 3 the 0.25 mM condition resulted in over three times the 
number of fluorescent pixels per cell above threshold in comparison to that of the control. 
Likewise, the 1 mM nicotine condition resulted in about twice the number of fluorescent pixels 
per cell above threshold in comparison to that of the control.  
          One explanation for the results seen in the current study is that the amount of myelin or the 
fluorescence detected by the FluoroMyelinTM Red within a glial cell may not directly correlate to 
the amount of myelination that occurs at the axons. The difference between myelin and 
myelination is an important distinction. In the literature, studies have found that irregularities in 
myelination are often caused by either glial cell death resulting in fewer glial-axonal interactions 
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or by axonal degeneration (Duncan and Radcliff 2016). Therefore, if glial cells within the 
nicotine conditions are producing more myelin but die more frequently and have less axonal 
interactions then there will be a decrease in myelination. This is also true for axonal 
degeneration, if the nicotine conditions result in axon injury or compromise the axonal transport 
than there would be a decrease in the myelination causing neuropsychological deficits (Cao et al. 
2013; Duncan and Radcliff 2016). For these reasons, a difference in myelin production may not 
be a significant indicator of disease manifestation as these disorders are often due to changes in 
myelination, a property that was not observed in the current study.  

Additionally, there are limitations present with the use of FluoroMyelinTM Red. 
FluoroMyelinTM Red is optimal in staining brain cryosections and often identifies myelination 
present on axons (Monsma and Brown 2012). In the current study FluoroMyelinTM Red was used 
to stain glial cells in cell cultures. An important limitation of using FluoroMyelinTM Red to stain 
glial cells is that FluoroMyelinTM Red is a lipid stain. While the staining of lipids is important in 
identifying myelin, an insulating sheath containing many phospholipids, it cannot specifically 
identify lipids belonging to myelin. This is primarily because myelin is composed of many 
glycolipids that are not myelin-specific (Stoffel and Bosio 1997). The main identifying 
characteristic of myelin is not determined by the lipids but instead by the proteins that aid in 
creating the myelin sheath (Demel et al. 1973). For this reason, it is hard to be certain whether 
FluoroMyelinTM Red was staining for myelin in glial cells.   

It is possible that FluoroMyelinTM Red is not optimal for identifying myelin present in 
glial cells making it a potential limitation. Additionally, the fact that myelination was not 
measured at the axon is a second possible limitation of the current study. For these reasons, I 
would refine the current study by examining glial-axonal interactions to quantify the amount of 
myelination that is occurring. I would then compare the amounts of glial-axonal interactions to 
understand which condition resulted in the most myelination overall. In the future, I would 
possibly expand this experiment by looking at myelin related genes such as stearyl-CoA-
desaturase 2 (SCD2) which is important in the synthesis and regulation of fatty acid chains 
essential for myelination (Schaeren‐Wiemers et al. 1995). I would do this to accurately explore 
the effect of nicotine on myelin gene expression, doing so would aid in possibly understanding if 
myelin expression is increased or decreased and would also help determine if there would be an 
increase or decrease in myelination. 

In general, this study provides preliminary evidence that nicotine may increase the 
amount of myelin present in glial cells. However, these results do not indicate whether the 
nicotine conditions result in an increase of decrease in myelination at the axon. Knowing the 
effects on overall myelination would provide better insight into how nicotine affects neuronal 
development.  
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